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1. INTRODUCTION

This document identifies and describes problems associated with NSIPS Release 0.2 software, and the solutions developed (if necessary) to work around those problems in the field.

The following tables identify the Software Problem Report (SPR) by number, the way to navigate to the problem (in parentheses), a description of the problem, and the workaround.  The sources for this analysis are approved SPRs. 

The workarounds listed in this document reflect the state of the NSIPS system SPRs as of 28 August 2002.  Workarounds and Technical Advisory Notes will be added to the NSIPS Web Site at URL: http://www.peoit- portal.navy.mil/peoit/communities/community.asp?UserID=2&CommunityID=218  

2. User Workarounds

This section contains a list of problems identified with the NSIPS program that have not been corrected with NSIPS Release 0.2.18.04.  These problems will be corrected in a future release.  Until the software has been updated, the actions described in the Workaround column should be followed if the user/System Administrator runs into the identified problem while performing updates/changes to the NSIPS database.  Any questions dealing with these workarounds should be addressed to the NSIPS Customer Support Center.

2.1 Field User Interface 

 *Denotes new entries
SPR #
Description of Problem
Priority
Workaround 

495*
LIMDU Reports Panel – (Go => Standard Reports => Transient Tracking Reports => Use => Limited Duty (LIMDU) => Add)

The LIMDU Report has no top of stack logic when selecting the EAOS for the report  Typically it selects the incorrect contract end date when the month on both contract end dates are the same, but the earlier contract end date has a day that is later than the last current contract end date, such as in dates of  12/01/2006 and 12/23/2002, the report will select 12/23/2002 because 23 is larger than 1.
3
User will have to verify EAOS and pen and ink the correct EAOS on the report.

490*
Active Strength Gain – (Go => Gains => Strength Gain => Use => Strength Gain – Create => Personal Info)

PeopleSoft creates an employee record #1 job row vice an employee record #0 job row for an active strength gain.  When a member is branch class 32, and has been mobilized, the member’s reserve top of stack job row reflects action/action reason of  RLS/IMB, DSC of 298 and Employment Table's Strength Code = K.  At this time, the active side gains the member and when the member is demobilized, the active side does a strength loss (SL) from mobilization.  This SL creates both active and reserve job rows with the same effective date of loss, action/action reason of SLS/DMB, DSC of 297.  The strength code (SC) is not changed from K to 1 until the reserve side of the house gains the member.  At this point, the active side can still see members record because they have a SC of K on the employeerecord #1 employment row.  Once the reserve side gains the member from mobilization, the SC changes back to 1 for the employeerecord #1 row.  In the case where the reserve side does not gain the member, then the employeerecord #1 SC stays at K.  If the member decides to go on active duty, instead of returning to the reserves, the active side (not on the same day) will perform a strength gain (SG) on the member.   PeopleSoft is pulling the employeerecord #1 employment row for this member and when they save the active SG it creates the job row as employeerecord #1 vice employeerecord #0 with action/action reason of SGN/STN and DSC of 100.  To summarize, the top of stack reserve job row will have SLS/DMB, DSC of 297 and reserve employment row will have SC of K before the SG is done.  The active side does the Active SG on a different effective day than the SL and will gain the member from a branch class 32 to a branch class 11.  When these conditions are met then the reserve SGN/STN job row vice the active job row is created.
3
User should call the reserve site and have them regain member from mobilization and then perform a SL  on member.  This way the reserve side record is correct and the active gain will create an active SGN row vice a reserve SGN row.  In the case where this is too late and the active side has already performed the SGN, then user will have to call in a trouble ticket (TT) and Tier 2 will have to update the member’s job row to reflect active vice reserve.  This will not solve the reserve record being incomplete at RHS since reserve side never got the opportunity to demobilize the member and perform a SL.

488*
Availabilities Reports – (Go => Standard Reports => Availability Reports => Use => Availability ADTAKE or Availability Status Verification => Add)

The Availability Status and Availability ADTAKE Tracking reports grow exponentially at larger commands because Availabilities are not purged when a member receives orders.  Report select criteria should exclude members with Availabilities on file once orders are received.


3
Use PeopleTools Query to create ADHOC report eliminating members with orders. Menu Navigation: Go => PeopleTools => Query. For details on creating an ADHOC Report, see the NSIPS Help System under AD-HOC QUERIES/REPORTS.



468*
Inactive Duty Training  – (Go => Inactive Duty Training => Forms/Sub Docs => Use => IDT Participation - Scheduled => Add)

A problem was reported with the IDT Participation report. Members scheduled to drill appear unless they have been rescheduled. Reschedules are not reflected on the report. 

3
Create an ADHOC report using PeopleTools Query.  Menu Navigation: Go => PeopleTools => Query. For details on creating an ADHOC Report, see the NSIPS Help System under AD-HOC QUERIES/REPORTS.



467*
Personal Data – (Go = Personnel Maintenance => Personal Data => Use => Personal Data – Create => Personal Info)

When a user goes into Personal Data and submits any kind of change that is not a test score change and the member being updated does not have any test scores on file. PS automatically enters zeros as defaults in the Test table.  Based on the creation condition, the table went from no value to a value and created the B29 message.  This B29 message is going up with values of 0, including the mandatory field of ASVAB test #.  All of these B29's are failing at corporate.  PS should not enter default 0 values in the Test table unless the user is specifically updating or inserting any values to that table.


3
User should submit correct data, if this data is available, so the data at the site and at corporate is up to date.



442
Activity Gain Panel – (Go => Gains => Activity Gain => Use => Activity Gain – Create => Report)

There is no method in which a user can accurately account for elapsed time if a member has taken leave enroute and that leave is non-chargeable. Additional information: It was suggested that the user charge the time as TDY or Travel, but there are two reasons not to do this: Reason 1: UMIDS allowed entry of an SB event to report the leave with absence type code 'J' (Graduation Leave) which allowed the leave to be easily tracked.  Reason 2: The user claims members are taking advantage of this if the leave is reported as TDY/Travel and then fraudulently requesting Graduation Leave.  Since there would be no record of leave with absence type 'J' in the member's Master Military Pay Account (MMPA), or in NSIPS, it could conceivably be granted a second time.
3
User can charge the non chargeable leave as TDY.

432
Address and Phone Listing – (Go => Personnel Maintenance => Address and  Phone => Use => Address and Phone)

Specifications for the Address and Phone listing exclude Voluntary Training Unit (VTU) members, whose Duty Status Code (DSC) is 600 (IRR VTU, Present for Duty).  Selection criteria specify DSC range  > 199 and < 499.  Need new business rules to correct the report select.
3
Use PS Query tool to identify members outside the DSC range.

425
Unauthorized Absentee Report – (Go => Legal => Use => Unauthorized Absence – Create => UA Report)

The current Business Rule (BR) for the record selection states "Select records where the Max Effective Date  DSC  is equal to 170, 171, 172, 173 and 174 and Job Table's "Loss Departure Date" field  is null and the Unauthorized Absence Table's "Page Six Begin Date" field is not null."  This rule does not exclude those member's who have reported from Unauthorized Absence (UA).  This report should only contain those members who are still currently in a UA status.  Please change the BR to state that the "Page Six Returned to Military Jurisdiction Date" field  as NULL.  This will ensure that those rows in the Unauthorized Absence table that have a date in " Page Six Returned to Military Jurisdiction Date" field will not be included in the report.
3
Sites will have to manually verify the report accuracy and white out or line out those members who have returned from UA.



412
Strength Loss Panel – (Go => Losses => Strength Loss => Use => Strength Loss – Create => Strength Loss)

When no "Workflow/Implementation Element"  #1 row exists on the active duty server where a strength loss for demobilization is performed, the DEPTID on the Strength Loss/Demobilization "Workflow/Implementation Element" #1 row is updated to equal the DEPTID of  the loosing active command, not the reserve home UIC.  The Naval Reserve Activity  (NRA) cannot check member in because “IMS code cannot be changed to RD2.  Member cannot be gained if member’s UIC is not the same as reserve home UIC on record.”
3
NRA needs to do an All NSIPS Member Request (GO-GET) to pull down a complete NSIPS record, including checkout from NRA for Mobilization (MOB).

397
Strength Loss Panel – (Go => Losses => Strength Loss => Use => Strength Loss – Create => Strength Loss)

After processing a Strength Loss, the detaching endorsement form produced does not reflect the Loss Departure Date, Loss Reason, Loss Type and Travel Time Authorized.  The report specification indicates that these fields should be included and have data.
3
User can hand write the values if local procedures require data on the actual printed report.

395
Activity Gains Panel – (Go => Gains => Activity Gain => Use => Activity Gain – Create => Report)

User submits Activity Gain and it fails.  Reject has not "rolled back" member's record yet, but user is able to save Activity Gain again thinking they are resubmitting the activity gain. Instead of re-transmitting the usual handful of Activity Gain related transactions, we send only an SG05 (A), which is not among the create conditions for the Activity Gain Update Workflow panel group.  The TOS Job Table's DEPTID, Report Date and Unit Identification Code Received From fields were identical. Need a BR to disallow save of Activity Gain to the same Unit Identification Code (UIC) and report date if DSC is 100 and Strength Code is 1.

User must wait for reject to apply (will be reflected on feedback report) before resubmitting failed transactions.

377
Pending Feedback Report – (Go => System Reports => Transaction Status Reports => Use => Feedback Data => Add)

The Retain Transmittal Log (RTL) and Pending Feedback Report criteria are based on the HR_DEPTID of the Operator Identification (OPRID), meaning the literal UIC of that person, not the OPRID's security access. These reports should be selected based on the HR_DEPTID of the member for whom the transaction was created.
3
In order to get a report displaying data relevant only to a single Human Resource  (HR), a Personnel Support Detachment (PSD) or ship would have to create a OPRID belonging to each specific HR and use each OPRID only for transactions on members belonging to the same HR.  If one person is responsible for multiple HRs, a civilian ID for each additional HR would be necessary.

374
Transient Tracking Panel – (Go => Transient  Tracking => Use =>  Transient Tracking => Transient – General)

Transient Tracking Reports need to exclude PGs/losses/discharges/death when record selections are as follows: Member's Employee Record Number must equal "0"; Member's Accounting Category Code (ACC) must equal "101", "109", "150" or "3XX"; Duty Status Code must be < 199 but not equal to 147 or 148. If no members exist with an ACC of "101", "109", "150" or "3XX", a negative report will be generated. This SPR is related to SPR 372.
3
User can purge transient information at time of loss/discharge/death.

359
Alphabetical List Locator Report – (Go => Standard Reports => Personnel Reports => Use => Alpha Locator => Add)

Current data is not always reflected on the report known as the Alpha Locator. The top of stack logic needs to be corrected.
3
The user can run an ADHOC query to pull the current data.

358
Prospective Gain Report – (Go => Standard Reports => EDVR Reports => Use => Prospective Gains => Add)

Cancelled orders are showing up on the Prospective Gain (PG) report as prospective gains.
3
Compare the PG report to the Draft Listing and annotate the cancellations.

356
Active Duty Strength Loss – (Go => Losses => Strength Loss => Use => Strength Loss – Create => Strength Loss 1)

The A24 (Z) and C50 (006) submitted to RHS when the Active Duty Strength Loss is released may reject (i.e. RHS doesn't have matching orders.)  If the NRA checks the member back in by updating the Individual Mobilization Status (IMS) code to RD2 before the reject applies, and DA processes the reject before the MOBEVT updates RHS to RD2, the reject "rolls back" the IMS code on NSIPS to reflect the value on the RHS database prior to RD2 update.  Need rules to prevent alignment of IMS code when these transactions reject.
3
The NRA needs to wait until rejected A24 (Z)/C50 apply before updating IMS code to ‘RD2’.



352
Rate Change Panel – (Go => Personnel Maintenance => Personal Data => Use = Personal Data – Create => Rate Change)

When the Rate Change Authority code is “T”, a member can be advanced from E1 to E2 or E3.  When the user attempts to advance an E1 to E3, an error message appears stating member can only be advanced to the next higher pay grade.
3
User must first advance the member to E2, then accomplish the advancement to E3.

349
Personnel Supervisor Workflow - (View => Navigator Display => Worklists => Select Worklist)

Workflow is being deleted on final approval of Activity Gains and Activity Losses.  If supervisor makes a change to an Activity Gain or Activity Loss, the Print button is grayed out and the Reporting/Detaching Endorsement forms can't be printed.
3
Supervisor can save gain or loss as incomplete and print the associated document or route the transaction back to the clerk to change.

329
Address and Phone Panel – (Go => Personnel Maintenance => Address and Phone => Use => Address and Phone)

When the Pay Record Access (PRA) Indicator flag is checked for  a member, it stops member from accessing records in the Address and Phone panel. The Address Search View is missing some logic involving the PRA Indicator field and prevents users from accessing records. The SQL needs to have a join to the Security Table. 
3
User should request from the site NSIPS SYSADM to unflag the Pay Record Access (PRA) Indicator in order to view the record. This can be done by logging in as NSIPSADM and using PRA => PRA Personnel Flag menu navigation.

312
Data Alignment – (Go => All NSIPS Member Request => Use => Request ALL-NSIPS Member)

During Data Alignment (DA), unsolicited MGTR 191/193 TAC is inserting a row in ps_job vice Updating. Additionally, it does not align the record. 
3
The alignment of the record will have to be done or submitted manually by Tier II.

309
Personal Data Panel – (Go => Personnel Maintenance => Personal Data => Use => Personal Data – Create)

When Personal Data Panel updates are completed by a personnel clerk and saved in workflow (WF) immediately upon completion of the activity gain, the data populated in the WF from the core tables will reflect the members previous duty station assignment for the Distribution Navy Enlisted Classification  (DNEC) code .  Since the Personal Data WF process only ungreys the fields that are different in the WF table from the core tables, the reason for change is not accessible to the supervisor, thus not allowing the supervisor to process the WF item.
3
Tier I Help Desk will have to manually modify the WF table to match the core tables.

308 
Activity Gain from Data Alignment  – (Go => All NSIPS  Member Request => Use => Request All-NSIPS Member)

Currently, when DA processes an activity gain or strength gain, Transaction Process Monitor (TPM)  only picks up the tables and fields that DA has recognized as needed to be updated and passes only those values down.  TPM should pass the full service record.
3
User should perform an All NSIPS Member Request (GO-GET) to receive the full service record that has been transferred through unsolicited transactions. 

305
Strength Loss Panel – (Go => Losses => Strength Loss => Use => Strength Loss - Create => Strength Loss 1)

DA errors out 9XX and 8XX strength loss transactions with the following error message “The effective date of the TAC is earlier than the effective date of the last job row….”
3
Change the effective date of the TAC and re-submit the transaction for alignment.

299
Evaluation Due Date Listing Report – (Go => Standard Reports => Personnel Reports => Use => Evaluation Due Date Listing => Add or Update/Display)

The incorrect UIC is being used for the “Last Evaluation Submission Date in Error” section of the report.
3
Make a pen and ink change and write in the correct UIC for the section in question.

294
Dependency Data Panel – (Go => Dependency Data => Use => Dependency Application/DOS =>Parents => SSN => OK=> Modify/Add Parent.)

When a user marks a dependent parent as deceased in the Dependency Data panel and saves the entry in that panel only, the system keeps the parent marked as a dependent.
3
User must go in the Parents tab, select Modify/Add parent modal, select Apply, then OK, then save the panel.   

 292 
Advancement Eligibility Reports Panel – (Go => Standard Reports => Personnel Reports => Use => Advancement Eligibility => Update/Display)

The Top of Stack Job table  selection for the E2-E3 Advancement report is currently using “<=” for the effective date.  This causes the report to not select all members for printing.
3
The user should use PS_QUERY as the tool for ADHOC reports.



286
Strength Loss Panel – (Go => Losses => Strength Loss => Use => Strength Loss - Create => Strength Loss 1 )

Reenlistment Code/Navy Loss Code combination of KCF/R1 needs to include Navy Loss Code of 802 Early Separation – Honorable as a valid value.  The current Strength Loss panel processing does not include this code.
3
  User can select Reenlistment Code “1 – Recommended for Reenlistment”. This will allow the user to select the proper Navy Loss Code.

276
Activity Losses Panel – (Go => Losses => Activity Loss => Use => Activity Loss – Create)

When a Previous Activity Loss already exists for the activity that is about to do another activity loss, the 640 TAC is not created.  This is prevalent to the RTC.
3
Report the problem to the Tier I help desk for further resolution.

275
Agreement to Extend Enlistment – (Go => Reports Status Monitor/Print => Use => Reports Status Monitor/Print => Reports Status Monitor)

The NAVPERS 1070/621 Agreement to Extend Enlistment form computes the members Expiration of Enlistment, as extended, and inserts that date in the first paragraph of the document.  This should also include any lost time added in.  The problem currently is that no lost time is added in at present.
3
Operator can pull up contract in Crystal Reports view screen, change date as necessary to incorporate any lost time from current enlistment, then print form from that screen.

273
Transient Tracking Report – (Go =>Transient Tracking => Use =>Transient Tracking => Transient - General)

 Currently at Corporate when a drop from strength is submitted by NSIPS, corporate puts member's Strength Code (SC) at DXXXX and the ACC at 393.  In our system this member reflects as DSC=143 and ACC=393.  This member should be showing up on the Transient Tracking Monitoring Report because of their ACC of 393.  This member should be tracked. 
3
Open a Trouble Ticket to update member's DSC to 136.

153
Inactive Duty Training  – (Go => Inactive Duty Training => IDT Individual => Use => Schedule)

The member is scheduled for Inactive Duty Training (IDT) drills and the member’s authorized limit is then changed by Reserve Headquarters System (RHS) to a lower number of drills.  When attempting to Record IDT period while using Drill Type codes of 9 (Unexcused Absence) or 8 (Authorized Absence) an error message appears stating that the member has too many drills for the current fiscal year.   
3
The operator must navigate to the Schedule/Reschedule panel (Go => Inactive Duty Training => IDT Individual => Use => Schedule) and delete or modify the extra drills.

142
Transfer Information Sheet (TIS)  – (Go => Orders => Use => Transfer Information Sheet => TIS Transportation)
This problem concerns updating a member’s automobile license information.  The user has the option of selecting the country in which the vehicle is registered.  However, if the member has a vehicle registered in the United States (US) and a vehicle registered in another country, the user cannot enter information for both vehicles.  The Vehicle License Country field controls the input for both Vehicle 1 Number and Vehicle 2 Number boxes.  This field also determines if Vehicle 1 State and Vehicle 2 State boxes are open for input.  For example, if the user selects US, both Vehicle 1 & 2 State boxes will allow the user to enter the state in which the vehicle is registered.
3
The user can enter the information for the second vehicle in the TIS Supplemental panel.

58
Dependency Data Panel – (Go => Dependency Data => Use => Dependency Application/DOS => Summary)

Erroneous messages are being sent to RHS by the Dependency Data panel for members separated from active duty.  These errors are due to Dependency Data Applications being completed on the active duty members after their date of separation.  
3
Users should update dependency data prior to transmitting the separation transaction to Navy Enlisted System (NES) or Officer Personnel Information System (OPINS).

9
Dependency Data Application – (Go => Dependency Data => Use => Dependency Application/DOS => Summary) 

If the member has two middle names, the Dependency Data Application will print the member’s name under the signature line as: FirstName MiddleName1 LastName MiddleName2 Suffix vice printing as FirstName MiddleName1 MiddleName2 LastName Suffix.  The only incorrect display of the name is under the signature line.
3
When printing Dependency Data Application for members with multiple middle names, the user (or member) can apply a pen and ink change to the signature line prior to the member signing the form.

2.2 System Administrator 

*denotes new entries
SPR #
Description of Problem
Priority
Workaround

429
The current NSIPS Backup process does not include the shut down of CORPFEEDBACK 2.  There are some sites out in the field that use CORPFEEDBACK 2 on a regular basis and the backup routine should include the net stop or shutdown of the service.
3
The NSIPS SYSADM will have to know to stop the CORPFEEDBACK 2 service prior to leaving for the end of the day.

479*
A Local Administrator account was created.  When logged on as the Local Administrator, attempted to "Request new user account" ,however, there were no menu items under the "Users" menu item, therefore, could not create, modify or delete a new user account.    
3
Create accounts as NSIPSADM.

480*
A Local Administrator account was created. When logged on  as the Local Administrator, tried to reset password , modify UIC access and delete and could not accomplish these tasks.
3
Use the NSIPSADM USERID for creating, updating and deleting USERIDs.

3. NSIPS infrastructure workarounds

This section identifies infrastructure or Upper Tier problems that are transparent to the NSIPS field user and to the NSIPS System Administrators.  In many of these cases, there is no workaround needed.  In the rare case where a workaround is needed, the workaround has been communicated to the NSIPS Program Administrators.  These software problems will be updated in a future release. 

3.1    NSIPS Administration
*denotes new entries
SPR #
Description of Problem
Priority
Workaround

183
The requirement for orders purge is not in the repository.  Data Management/Batch Processing Architectural Infrastructure Segment (AIS) has no Active Duty Orders purge process for a local server (the record purge process uses orders as a constraint to deleting the member’s record completely).  The current purge package has a unique Active Duty Orders Purge function.  This deletes cancelled orders that are 30 days old.  It also will delete orders for members who are currently assigned to the DEPTID that are equal to the UIC Ultimate Duty Station field and the Orders' Ultimate Duty Station Estimated Date of Arrival is 60 days in the past.
3
This SPR is for system documentation only and has no impact to the user.  There is no user workaround. This SPR is to document the need to add the business rules into the requirements business rules repository.  

313
The Unsolicited MGTR 298 TAC is a cancellation of an Activity Loss.  Data Alignment is failing 69% of them with the error "There is no matching Job Table row to cancel for this TAC."  After looking at the TAC and the data in ALLNSIPS, found that the code is passing those where the TAC effective date = Job Table's Activity Loss Report Date.  Therefore, it succeeds only when the gain and loss takes place on the same day.  Which means that all others will fail.  The code needs to be changed where the TAC effective date matches the Job Table's Activity Loss Loss Departure Date, not the report date.
3
Tier II will need to remove the ALS row manually from ALLNSIPS and all it's multisites.  Workaround is to have User submit transaction in NSIPS versus On-line.



317 
When the delete record count for a single purge function (ex. dm_ps_trig_purg, dm_ps_ina_idt_purg) is too high, the dm_purge routine will show that it was successful, but in fact it did not complete the deletes.
3
There is no user workaround. The DBA will have to run the purge function manually on the users server.  This will occur mostly on the dm_ps_trig_purg function because of the high amount of records currently on servers.

340
 If DA receives an OPINS sync file on the same DA run that it receives an unsolicited F8 MGTR(conversion), DA will error out the sync file because it still thinks member is enlisted,  thus preventing the rank from updating
3
There is no user workaround.  Tier II will have to fix this problem as it arises.

346
The name is blank on the Retained Transmittal Log for transactions released by a Civilian OPRID.
3
Create an ADHOC query to pull the name.

347
Currently, Atransporters run to ensure that a workitem has been sent and unzipped successfully.  This process creates a file (. pfl extension) at the site that the workitems are being sent.  Once all workitems are successfully sent and the files renamed to .tmp and .zip, the files are renamed to .txt.  It moves the files from the Pending folder to the Archive folder.    Typically, it usually leaves anywhere between 20-40 .pfl files a day at ALLNSIPS.  Recently due to the high network traffic and inefficient connectivity being experienced, the amount of .pfl files left over at ALLNSIPS has increased 10 fold.  It's averaging around 300 a day in the replication workitems and CAI responses folders.  Normally, the workitems have already been received by ALLNSIPS. Unfortunately, because the sending ATransporter has not been able to complete it's acknowledgement process, it thinks the files were not received successfully at ALLNSIPS and will re-send them after 3 days.  This itself is contributing to high network traffic and to the extra processing time that ARegional is spending and deleting transactions it has already received.  This process needs to be cleaner and more efficient and should take into consideration the possibility of faulty networks.  These extra .pfl files are currently being cleaned up on a daily basis to ensure that resources are available for other processes.
3
Workaround is not needed.  ATransporter's process will re-send the workitems that may or may not have been received by the receiving site.    

417
Currently DA uses the conversion and load (C/L) package when converting data for PS_N_ACTIVE.  There are 3 fields in PS_N_ACTIVE (N_MEAL_PASS_EXP_DT, N_MEAL_PASS_NUM, and N_MEAL_PASS_TYP_CD) which the C/L package currently has set to NULL.  This is wiping out any information the sites are completing for meal pass when DA receives any transaction from corporate.  Need to block these 3 fields in DA.


3
User must continue to enter meal pass info each time DA wipes it out.



444
Request a change to the local server data management purge requirements to not purge a member's record if Access Table's Date Stamp field > System Date <= 14 days.  Many trouble tickets are opened because a user requested a member's record but the purge routine deleted the record before a gain transaction (usually) could be completed.  A constant backlog at ALLNSIPS has exacerbated the problem. 
3
Do the ALLNSIPS Member Request early in the week and complete gain as soon as record is available. Repeat the request if record is purged before gain can be completed.

445 
The create conditions need updating in the Allowances work product to remove the "and PS_JOB.N_DUTY_STAT_CD <"199" condition from the following messages: 3631, 3501, 3502, 3503, 3503(1), 3504, 3534, 3601, 3602, 3603, 3604, 5102, 5103, 5104, 6501, 6502, 6503, 6701, 6702, 6703, 6704, 6801, 6802, 6803, 6804, 4001, 4002, 4003, 4004, 3903, 5101.  In some cases, these transactions are not being generated although the process works correctly.  At the time the process is approved, the member's DSC is 100, and then an activity loss is approved changing the database value of DSC to 199, depending on the timing of COMMS process of the work Item. If the database reflects DSC of 199, no transaction is created. This condition is not necessary for the proper generation of the message since the panel restricts the user from processing members with invalid DSCs.


3
Delay entry of Activity Loss a day; make sure ALocal is always running

458 
System reports (RTL, Pending Feedback, Feedback) use the Message Status Table's Originating DEPTID field to determine whether data should be displayed on the report considering the selected UIC(s) and/or security profile of the requesting OPRID.  There are 36 reserve panel groups for which this field is not consistently populated, based on research at the 7 area servers.  Only 4 active panel groups have been identified, and the condition existed on fewer than 5 transactions per panel group on only 1 of 7 active locals checked (including RTC and NTC).      ALocal populates this field based on the value stored in KEY15 on the trigger table.  For every blank Originating DEPTID in production, KEY15 is also blank.  


3
No workaround at this time.

469*
The Projected Loss Report errors out after processing .  The report  does not compile and  sits in the "processing" state for hours.   

3
Use PeopleTools Query to create an 

ADHOC report. Menu Navigation: Go => PeopleTools => Query.  For details on creating an ADHOC Report, see the NSIPS help System under AD-HOC QUERIES/REPORTS.



APPENDIX A–ACRONYMS AND ABBREVIATIONS

ACRONYMS AND ABBREVIATIONS
Abbreviations are in Italics

ACC
Accounting Category Code

ADSW
Active Duty  Special Work

AIS
Architectural Infrastructure Segment

ALS
Activity Loss

BAQ
Basic Allowance Quarters

BR
Business Rule

BR/CL
Branch/Class

DA
Data Alignment

DBA
Data Base Administrator

DDS
Direct Deposit System

DJMS-AC
Defense Joint Military Pay System-Active Component

DNEC 
Distribution Navy Enlisted Classification

DSC
Duty Status Code

DOS
Dependents On Station

EAOS
Expiration of Active Obligated Service

EDVR
Enlisted Distribution Verification Report

FAQ
Frequently Asked Question

FOIA
Freedom Of Information Act

FTP
File Transfer Protocol

HR
Human Resource

IAP
In-Assignment Processing

IDT
Inactive Duty Training

IRR
Individual Ready Reserve

LCDR
Lieutenant Commander

LIMDU
Limited Duty

MMPA
Master Military Pay Account

MOB
Mobilization

NES
Navy Enlisted System

NRA
Naval Reserve Activity

NSIPS
Navy Standard Integrated Personnel System

OPINS
Officer Personnel Information System

OPRID
Operator Identification

OUTCONUS
Outside Continental United States

PEO-IT
Program Executive Office for Information Technology

PG
Prospective Gain

PPSUIC


Personnel Pay Support Unit Identification Code

PRA
Pay Record Access

PS
People Soft

PSD
Personnel Support Detachment

PVCS
Polytron Version Control System

RHS
Reserve Headquarters System 

RUAD
Reserve Unit Assignment Document

SC
Strength Code

SELRES
Selected Reserve/Reservist

SG
Strength Gain

SL
Strength Loss

SPR
Software Problem Report

RTC
Recruit Training Center

RTL
Retain Transmittal Log

STASS
Standard Training Administration Support System

TAC
Transaction Accounting Code

TDY
Temporary Duty

TIS
Transfer Information Sheet

TOS
Top of  Stack

TPM
Transaction Process Monitor

TSP
Thrift Savings Plan

TT
Trouble Ticket

UA
Unauthorized Absence

UIC
Unit Identification Code

UMIDS
Uniform Microcomputer Disbursing System

URL
Uniform Resource Locator

US
United States

USERADM
Default User Identification

USERID
User Identification

VTU
Voluntary Training Unit

WF
Work Flow
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